


PMB200B, Krasileva  							            Workshop 1
Project 1 Constructing protein family phylogeny with webservers 

This project will allow you to gain the skills necessary to identify the evolutionary origin of your protein of interest and analyse its homologs. We will annotate the domains in your protein and identify the closest Arabidopsis protein that they are related to. Since we know so much about Arabidopsis, knowing the evolutionary relationship between your protein and Arabidopsis would be informative. Once you are happy with the analyses, you can pick another plant species to include in your evolutionary analyses.

In this exercise, no command line skills are required, however you are welcome to use them if you prefer.

1.1 Domain prediction 

Tool: Pfam search - http://pfam.xfam.org/browse
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Method: 
Follow link 
Navigate to search at top of web page 
Click on sequence then paste your sequence in the box and press submit. 

Results 
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1. Shows you the predicted domain composition for your protein sequence. 
2. The conserved type of protein sequence predicted 
3. Where in your sequence the region is predicted? If overlapping domain predictions treat with caution 
4. A description of confidence in the hit accounting for likelihood of random matches due to multiple searching. The lower the e-value the greater confidence in the hit. 
5. Clicking show alignment will give you a view of the match between the HMM and your query (#SEQ) if your query is mainly highlighted in green this means it is high posterior probability match whilst regions in red have low posterior probability. 


You can follow the link next to domain names to find out more about your them including Pfam IDs which you need for later.

If your protein has more than one domain then note all of them down in the group spreadsheet and then paste the protein sequence into CDD search, then press live search. If a domain appears in both searches with a low e-value you can be more confident it exists, and it will be more likely to work with the remaining steps. 
Tool: NCBI CDD https://www.ncbi.nlm.nih.gov/Structure/cdd/wrpsb.cgi?

The CDD column only needs to be filled in if you used the NCBI CDD tool. 

Link to group spreadsheet: https://docs.google.com/spreadsheets/d/10CpRp6iwr1mYy3XlvwqkBOK-ML0Odj3EP7gtZLghVzI/edit?usp=sharing

Pfam ID of domains: 

Positives: 
Easy to use
Clean visualisation 	
Can search multiple protein sequences at once 

Limitation: 
Limit to bulk sequence upload and sequences must be protein
Data not available for bulk downstream 
Cannot search many sequences for just one specific domain of interest

NB command line users: you can use HMMER (hmmscan) and Pfam-A installed on this machine in place of webservers.

1.2 Retrieving proteins with domain of interest 

Tool: Biomart
Link: 
Phytozome:  
https://phytozome.jgi.doe.gov/biomart/martview/fa2c76032665114d5ef856f01ad6df97
Plant Ensembl
https://plants.ensembl.org/biomart/martview/4dd2ed2030be39022f6b96b974e838c7

Biomart allows you to extract sequences and many other features from genomes and proteomes by specifying your requirements. Biomart is available under Tools on the Phytozome webserver
[image: ]
Method:

1. After navigating to the Biomart tool, choose ‘V12 Genomes and Families’ from the drop-down menu on the right:
In the next drop-down menu, choose ‘Phytozome 12 Genomes’
[image: ]


2. Then on the left, click on ‘Filters’ and check ‘Select organisms’, then choose ‘Arabidopsis thaliana’ (or another organism if you want to try it). Next, click on ‘Protein’ to expand this section.
[image: ]
3. Click ‘Limit to genes with PFAM IDs’ and type the Pfam domain identification number(s) that you got for your integrated domain from the Pfam webserver. 
	Try first to retrieve proteins that have all domains shared with your protein
	Then see how many more proteins you get if you put each domain separately
[image: ]
4. After you are done with filters, you need to go back to the panel on the left and click on 
[image: ]


Now, you can specify that in your results, you want to download sequences, and peptides 
[image: ]
5. Finally, you can click on ‘Results’, check that you have results downloaded in ‘FASTA’ format and hit ‘Go’ to download a file with all sequences in Arabidopsis that have the domain you specified.
[image: ]

6. The results should be in your downloads folder. Open the file and you should see fasta with all full-length sequences containing your domain of interest.
Add your sequence to this file for next steps of the analyses and save file in your Project 1 folder.

NB command line users: You can download Pfam database on your computer and annotate all domains in proteins with pfamscan. If you output --tblout you can then use grep to search for and extract proteins with a given domain.


1.3 Alignment 

Tool: Cobalt aligner 
Link: https://www.ncbi.nlm.nih.gov/tools/cobalt/re_cobalt.cgi
[image: Screen Shot 2017-08-05 at 12.29.57.png]
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Method 

1. Choose file upload (if you have used Biomart this should be in your downloads folder).
2. Look at advanced options and consider if these are necessary 
3. Align 

Results

If a pop-up message “No results available for the given RID: SBBHYM2621S”  appears on your screen close the message. 
[image: Screen Shot 2017-08-05 at 14.48.40.png][image: Screen Shot 2017-08-05 at 12.40.45.png] 

The dashes represent and insertion/deletion events in this sequence compared to others with which it is aligned. The regions which align well will be coloured. This is a good point to check if the NLR-ID is aligning to your other proteins with the same domain. 

1. Click download then gapped fasta  
2. Take a screenshot of the query to gene id labels


Are various options available which you can look at in more detail if these are of interest to you later. 

Advantages
Easy to use 
Takes multiple formats 
Lots of output information which is downloadable 
Multiple output formats 

Limitations
Limit on number of sequences 
Less control over parameters 
Can take longer or fail due to internet connection and weight of traffic on web page 
Not the best aligner 

NB command line users: You can use HMMER (hmmalign) and hmm for the domain of interest instead of webservers (see project 2 for details).

1.4 Alignment curation 

Tool: Jalview 
Location: Start > 

Method
1. Visualise conservation of amino acids, this can be done through clicking on colour then ClustalX, then by conservation.
2. Drag the scroll bar to look the whole way across the alignment, this will allow you to identify regions of high conservation which is also indicated by the bar chart at the bottom. This is the domain region which you want to keep. 
3. Remove region composed of many gaps before where nearly all sequences clearly align. Do this by clicking on the first ‘-’ or letter in the first sequence and dragging across and down to cover the whole region to remove. Then navigate to edit at the top of the alignment window and click cut. Repeat this for the region after which the sequences do not align well. Jalview often requires you to drag from left to right when trying to select a region. 
4. Highlight sequences, other than your domain of interest, which do not align well using a mouse click on the sequence name and holding down Ctrl to highlight multiple at once. Remove these sequences using Edit - Cut. 
5. Remove columns of all gaps by Edit > Remove empty columns 
6. Save alignment File > Save as > Save in Project 1 in folder of NLR-ID you are working on

NB command line users: we have installed belvu to enable alignment viewing and editing

1.5 Phylogeny construction 

Tool: IQ-Tree 
Link: http://www.iqtree.org/
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Method 
1. Navigate to Web Service
2. Input data 
a. Alignment file : click option Browse then select alignment from clustal omega 
b. Sequence type: Protein 
3. Substitution model
a. Auto 
b. Free rate model tick (This allows variation in substitution rate beyond gamma distribution bounds? I think.)
4. Submit job 

Results 

IQtree will redirect you to a results page and give you a link which you can return to later to find your results. 

Link to tree : 

Whilst IQ-Tree is running you can navigate to the run log tab to see the tree builders progress. The sidebar and email will inform you of when the run is complete. 

Once finished you can view the log to see if there were any problems such as sequences removed as two where identical or sequences with few aligned columns being present in the alignment. 

Click the download selected jobs button on the bottom left of the page. 
Then rename the .contree file with your name and the domain of interest as this will make it easier to find your own tree later on iTOL.  

Advantages 
Allows use of complex models and options
Easy to use 
Visually appealing 

Limitations 
Memory and run time are limited 
Model selection is not tested after tree construction by IQ-Tree and this can result in overfitting a model to your data (only a concern for those very interested in phylogenetics). 

Phylogeny run time for 373 seq of length 100+ proteins - A whole day 

Phylogeny run time for 10 seq - A few minutes

NB command line users: you can run your phylogeny with RAxML as outlined in project 2.

1.6 Phylogeny visualisation 

Tool: iTOL
Link: http://itol.embl.de/login.cgi
(you will need to register and create an account, it is free)

Method

1. Navigate to upload tree files and upload the tree saved from IQ-Tree <your_file_name>.contree
2. Click on the blue hyperlink with the name of the file you uploaded
3. Visualising tree alter the view of the tree using the different control options. 
[image: ]
Zoom in/out of tree

Whole tree view 

Search for leaf label 


[image: ]Scaling factor - Length of  horizontal and vertical branches

Bootstraps - Normally want to display to provide information of support for branch

Display range- This determine bootstrap values you can see helpful to prevent clutter, additional clutter 



4. Save/restore view, recommended to do regularly to prevent losing work. Can save multiple views of the same tree. [image: ]Display mode - Change the way the tree is displayed 

Branch length - Useful to include as are informative about proportion of mutations which have happened along that branch

Labels - Refers to text labels for leaves



5. Exporting tree, click on the export tab of the control panel then you can use the format drop down menu to select more conventional formats such as PDF and PNG. 

NB. You can decorate your tree with various information about your proteins of interest. For more detail see iTOL help pages. http://itol.embl.de/help.cgi#annot


1.7. Sub-family phylogeny

Now that you have a global view of the protein family and its evolution, you can identify the clade that contains your sequence of interest and all other sequences that are closely related to it and refine their phylogeny.

For this, you can click on the node, and export all gene names that belong to a particular node.

Using the gene names, you can go back to Biomart, extract amino acid sequences, and now perform full length global alignment, using an aligner such as MUSCLE or PRANK

MUSCLE: https://www.ebi.ac.uk/Tools/msa/muscle/
PRANK: https://www.ebi.ac.uk/goldman-srv/webprank/

Now, you can repeat steps 1.4-1.6 for a more refined phylogeny.





Project 2 Constructing protein family phylogeny with command line 

This command-line oriented project will show you how to construct protein family phylogeny using NLR family as an example. If you are command-line novice - give it a try, you can always do most of this project already with skill set you acquired in project 1, so if you are not interested to scale up your analyses, go to project 3 for more in depth functional analyses. If you are command-line expert, follow instructions below to download software on your machine.

Required software:

HMMER: http://hmmer.org
Prank: http://wasabiapp.org/software/prank/
Belvu (or use Jalview from Project 1): https://www.sanger.ac.uk/resources/software/seqtools/
RAxML: https://cme.h-its.org/exelixis/web/software/raxml/

Cheat sheet for first time command line users

1. Open Terminal
[image: Screen Shot 2017-08-07 at 08.15.24.png]


2. Navigate to the folder where you would run analyses by typing

mkdir ~/Documents/PMB200B_Project2/
cd ~/Documents/PMB200B_Project2/

cd  				change directory (navigate between folders and subfolders)
ls  				list all files and folders in current directory
head <filename>  		see first 10 lines of a file
less <filename>  		see content of a file (type ‘q’ to quit)
command -h or --help 	usually will display how to use it
Hitting TAB key helps you auto-complete file path
Ctrl A takes you to the beginning of command line
Ctrl E takes you to the end
Ctrl C exit a process or writing of a command 
Hitting up arrow allows you to scroll through previous commands that you typed

2.1 Alignment 

1. Download full proteome of your species of interest from Phytozome. 

Example: rice
https://phytozome.jgi.doe.gov/pz/portal.html#!info?alias=Org_Osativa
Click to Bulk data download, login in and you will find yourself at FTP
You can find proteome under /annotation/Osativa_323_v7.0.protein.fa.gz 

2. Since all NLRs have a conserved NB-ARC domain, you can extract proteins containing this domain’s HMM from plant proteome and align them using HMM as a template. Go to http://pfam.xfam.org/family/NB-ARC 
             and download http://pfam.xfam.org/family/PF00931/hmm

Place this hmm file into you project folder.

If you are curious - look inside the .hmm file to see how the domain is described as a statistical model of aa probabilities at each position of the domain.

What if your protein of interest does not have pre-built HMM describing it? You can build HMM yourself using `hmmbuild` function in HMMER.

What if HMM at Pfam does not adequately describe your protein family of interest. For example, the NB-ARC model above has been built from diverse organisms including not only plants but also animals, bacteria and archaea. Therefore the resulting HMM is a best fit to describe full diversity of this protein family.

Most of plant NLRs have a conserved NB-ARC domain that is larger than what Pfam HMM describes. NB-ARC of plant NLRs include additional motifs such as ARC2 and MHD. Therefore, we built plant specific HMM that you can download here: 

Bailey et al Genome Biology 2018, Additional file 16

You can do the alignment steps below with both Pfam HMM and our HMM and compare the results.

As a bonus, you can download any of the curated functionally annotated NLRs from http://prgdb.crg.eu/wiki/Category:Reference_R-Genes,_manually_curated and include them in alignment and phylogeny. Place them in project folder as well.

Method

Prerequisites: 
hmmer-3.1b2 from HMMER suite

hmmsearch -o <domainsofinterest.hmmalign.sth> <domainofinterest>.hmm <genomedata>.faa

hmmalign --trim -o <domains of interest.fa>_hmmalign.sth <Domain of interest>.hmm <domains of interest.fa>

You can both search and align proteins to a domain of interest in one step

hmmsearch -A <domainsofinterest.hmmalign.sth> <domainofinterest>.hmm <genomedata>.faa
                                                    
Hmmalign produces an alignment in Stockholm format however for visualisation purposes we would like the alignment in fasta format. ‘esl-reformat’ reformats to fasta format

esl-reformat -o <domainsofinterest>.hmmalign.fa afa <domainsofinterest>.hmmalign.sth

2.2 Belvu alignment view 

The alignment can be viewed using the programme belvu and further refined to exclude gappy columns to trim it to the aligned region. 

Method
1. belvu <*hmmalign.fasta> 2> <*hmmalign.fasta.log>


2. Right click on the dash before the first region of high conservation, in the example I have marked the position with an arrow. 

3. Edit -> Remove columns left of selection.... 

4. Then right click on the residue flanking the last region, then use Edit -> Remove columns right of selection

Now we have our region of interest we can clean up the alignment 

5. Edit remove gappy columns 
a. 90% gaps 
I have chosen 90 here as an arbitrary cut off but you can use more stringent cut-offs however as there is no easy undo in belvu if you remove too much of the variation in your sequences you may have to start refinement again. 

6. Repeat the above but this time removing gappy sequences.  

Once you are happy with your curation then save. 
7. File -> Save as <input>.belvu.fa
[image: ]

2.3 Phylogeny with RAXML

We are now ready to build a tree of the protein domains to visualise how they may be related evolutionarily. For this we are going to use the RAXML programme to build a bootstrapped maximum likelihood tree. 

Method
Prerequisites:
raxml


1. raxmlHPC-SSE3 -f a -x 1123 -p 2341 -# 100 -m PROTCATJTT -s <input alignment>  -n <input alignment>.raxml

Example
~/biotools/standard-RAxML-master/raxmlHPC-SSE3 -f a -x 1123 -p 2341 -#100 -m PROTCATJTT -s athaliana.0.001.NB-ARC_hmmalign.belvu.fa -n athaliana.0.001.NB-ARC_hmmalign.raxml

-f 	    | rapid Bootstrap analysis and search for best-scoring ML tree in one program run
-x 	    | Random starting seed for bootstrapping
-# 	    |  Number of bootstraps 
-p 	    | Random starting seed for maximum likelihood tree 
-m            |  Model used to explain likelihood of amino-acid change 
-s 	    | Multiple sequence alignment 
-n 	    | Output file prefix 
-U	    | Skip gappy columns NB only use if have relatively few gaps in alignment 

2.4 Itol visualisation

As in level 1 guide but choose file RAxML_bipartitionsBranchLabels*.raxml

3. Extended functional analysis: 
3.1 Metabolic prediction through KEGG database

 Identify your protein of interest on the KEGG database 

https://www.genome.jp/kegg/genes.html

Your can enter your gene NCBI ID at the bottom of the page, alternatively, you can search with BLAST https://www.kegg.jp/blastkoala/

3.2 Structure modelling

3.2.2. Homology-based

Phyre2 predicts structures based on the following algorithm (https://www.nature.com/articles/nprot.2015.053)

1) homologs are gathered for the entered query sequence
2) homologs are aligned, and the secondary structure is predicted de novo
3) HMM describing the sequence and its homologs as well as predicted secondary structure is built from the alignment
4) HMM is scanned against a database containing HMMs of proteins with known structures
5) Top scoring hits are used to construct backbone model, loops are modelled separately and then side chains of amino acids are placed.

http://www.sbg.bio.ic.ac.uk/phyre2/html/page.cgi?id=index

Phyre2 workshop with explanation of results: http://www.sbg.bio.ic.ac.uk/phyre2/workshops/2019/Cambridge/worked_examples.html

If you have high confidence models, you can download and visualize them on your computer using Chimera software: https://www.cgl.ucsf.edu/chimera/

3.2.3 Ab initio structure prediction

You can also try ab initio structure prediction and compare it to results from Phyre2.
https://robetta.bakerlab.org

3.3 Overlaying amino acid diversity on structural model 

Chimera software: https://www.cgl.ucsf.edu/chimera/

Mapping sequence conservation on protein structure tutorial: https://www.cgl.ucsf.edu/chimera/data/tutorials/systems/outline.html
 






Appendix - Key terminology 

domain (of a protein)
a distinct functional and structural unit of a protein. Often, corresponds to a region of sequence conservation that can function, fold and evolve independently of the rest of the protein chain.

family (of proteins)
a group of proteins of the common evolutionary origin, that share similarity in function, sequence and domain structure.

Profile Hidden Markov Model (HMM)
a statistical model that turns a multiple sequence alignment into a position-specific scoring system suitable for searching databases for remotely homologous sequences. See Eddy SR Bioinformatics 1998 https://doi.org/10.1093/bioinformatics/14.9.755

homologs
sequences that share a common evolutionary origin. Beware of substituting sequence similarity with homology, the former can be expressed in % identity, the latter cannot be partial because two sequences are either homologous (share a common ancestor) or not. 

orthologs
sequences that share a common evolutionary origin and that were last separated by speciation

paralogs
sequences that share a common evolutionary origin and that were last separated by gene duplication

branch (of a phylogenetic tree) [includes “branch length”]
Lineages of taxonomic units that link nodes within a phylogenetic tree.
In a rooted tree, branches indicate direct transmission of genetic information from the taxonomic unit located at one end (parent) of the branch to the other (child). To determine the direction of transmission, consider removing the branch of interest from the tree to yield two unconnected subtrees, each of which contains only one of the nodes directly linked by the branch of interest. The subtree containing the root node contains the more ancestral of the two nodes linked by the branch of interest; hence, the direction of transfer of genetic information is from this more ancestral node to the other node linked by the branch of interest. For an unrooted tree, it is unknown which of the subtrees contains the root node, hence in unrooted trees the direction of transmission of genetic information is not specified.
If the branch is part of a scaled phylogenetic tree, then a value is associated with the branch that indicates some measure of the difference between the two taxonomic units directly linked by the branch; this value is often referred to as the "branch length". If the tree is "unscaled", no such value is associated with the branch, that is, no branch length is specified or defined.
A branch that links two internal nodes is known as an internal, inner, or interior branch. Branches linking an internal and an external node are referred to as external branches (also terminal branches).

branch length
See “branch”.

node (of a phylogenetic tree)
In phylogenetic trees, nodes represent taxonomic units. Nodes between which there is direct transfer of genetic information are linked to each other by branches. Nodes in a phylogenetic tree that are attached to only a single terminal branch are referred to as terminal nodes (also external nodes, leaves, or tips), and represent operational taxonomic units. Nodes attached to more than one branch are referred to as internal (also interior) nodes and represent hypothetical taxonomic units.

phylogenetic tree [includes “root”]
A description of a path of transmission of genetic information between a set of operational (and usually also hypothetical, if the tree contains any internal nodes) taxonomic units (see Operational Taxonomic Units (OTUs) and Hypothetical Taxonomic Units (HTUs)). Tree structures, as understood in graph theory, can be used to represent phylogenetic trees. In graph theory, trees are defined as undirected graphs for which exactly one path connects any two nodes (or "vertices"), i.e., a tree is any connected graph that does not contain any cycles. Phylogenetic trees consist of nodes (operational or hypothetical taxonomic units) that are connected via branches.
Phylogenetic trees are described as either "rooted" or "unrooted". In a rooted tree, there is one node (the "root node") that represents the most recent common ancestor of all other taxa in the tree. While it is assumed that such an ancestor also exists for an unrooted tree, i.e., that all the OTUs share a most recent common ancestor, in an unrooted tree no inference is made about where on the tree this HTU might be.

root
See “phylogenetic tree”

sister group
In a rooted bifurcating tree, any internal node represents an ancestor of two subtrees. These two subtrees are sometimes referred to as "sister groups" of each other, i.e., subtree A is the sister group of subtree B (and accordingly subtree B is the sister group of subtree A). As this definition depends on knowing the direction of genetic transmission along the branches of the tree (i.e., which nodes/branches are ancestral and which are descendant), it is only possible to identify sister groups in the context of a rooted phylogenetic tree; in unrooted trees the direction of transmission of genetic information is not specified, so it is not possible to identify which of the subtrees linked to an internal node are ancestral and which are descendant. To overcome this problem, the concept of adjacent groups was developed for referring to subtrees linked to the same internal node in unrooted trees.

subtree
A tree obtained by detaching a branch from a larger phylogenetic tree.

taxonomic unit
Phylogenetic trees can be used to describe patterns of genetic transmission between different kinds of entities, for example: different species, different individuals within a population of the same species, different genes within a gene family. The term "taxonomic unit" is used to refer to the entities between which patterns and paths of genetic transfer are described. Thus, for some trees, the taxonomic units will be individuals within a population, in other trees they will be different species.

Phylogeny definitions taken from entries written by Aidan Budd and Alexandros Stamantakis in the 2nd edition of the “Dictionary of Bioinformatics and Computational Biology” (eds John M. Hancock and Marketa J. Zvelebil)
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